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Hello Craig,

For your review.  If possible, lets touch base this afternoon and refine based on your feedback. 
Thank you.

Dave
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Objective, Scope and Team

Background/ objective

The Muskrat Falls Oversight Committee is accountable to Cabinet for providing reliable and transparent oversight on the cost and schedule performance of the Muskrat Falls Project.  The Oversight Committee has requested that EY perform a review of the Muskrat Falls Project’s project management processes related to cost and schedule.

The objective of this review is to assess the management processes and controls at the Muskrat Falls Project to give the Oversight Committee insight on the appropriateness of such processes and provide the Oversight Committee assurance as to the completeness and quality of information being provided to the Oversight Committee.

You have indicated there is commercial sensitivity of the information required to perform this review.  EY will report on management’s processes and controls and will work with the Oversight Committee and Nalcor to properly protect commercial sensitivity project information. 



Scope 

To deliver on these objectives, the scope of the review includes assessing the appropriateness of the Muskrat Falls project management processes related to:

Schedule management, reporting and control

Cost management, reporting and control

In addition, in order to properly assess the Schedule and Cost management processes and the objectives of this review, EY will be required to assess elements of the Scope and Risk management processes.  

We will work with Nalcor Internal Audit during the planning phase of this engagement to identify opportunity to leverage work performed by Internal Audit (avoid duplication) and structure opportunities for Internal Audit to participate or leverage the work performed by EY in this engagement.

EY Team

David Steele – Partner

Richard Noble – Associate Partner



Aman Gill – Senior Manager

Emiliano Mancini – Manager







Ernst & Young LLP   |  Page ‹#›





It is possible to apply this template to exiting presentations.

Have the latest presentation template open

Click on the View tab and select Normal 

Delete all unwanted slides

Click on the Insert tab from the menu bar and select Slides from Files

Click on Browse. Navigate to the presentation you wish to update with the new template. Highlight the presentation and click Open 

Wait for the slides from the presentation to load and click on Insert All. Then click Close

Check the inserted slides to ensure that the most appropriate master slide has been used on each slide 

To change the master applied to a slide select the slide you wish to apply a different master to then click on the Format tab from the menu bar and select Slide Design

From the Used in This Presentation section choose the master you wish to apply to the slide and hover over it to reveal a drop-down arrow. Click on the arrow and select Apply to Selected Slides

It is important to thoroughly check the presentation to ensure that no further formatting is needed.

May 22, 2008

Presentation title
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Approach

Our approach below shows how we will execute this engagement.  Though our approach is structured, we have flexibility to meet your requirements.  The three major components of our approach are: planning, execution and reporting.  Detailed activities under each component are described below. 

Planning

Activity 1:  Kick-off meetings

EY will work with the Oversight Committee and the Muskrat Falls Project Group’s point of contact(s) to establish an engagement protocol to review and confirm scope of activities and related timing.   

An internal kick-off meeting will be held with the Oversight Committee to develop a common understanding of the scope and objectives of the engagement, establish communication/ reporting protocols, and discuss potential risks. Another kick-off meeting with Nalcor will be conducted to discuss the scope, data requirements and timing.  	

EY will also meet with the Nalcor IA team to review their work completed to date to identify areas where reliance can be placed to reduce the scope of work for this engagement.  In addition, areas where IA can place reliance on the work to be performed in this engagement will also be identified.

The Nalcor liaison, review and feedback mechanism/ protocol will be co-developed in the planning phase.



Activity 2: Data collection and review

EY will develop an “information and document request listing”.  We will then work within agreed upon protocol to collect data from the appropriate point of contact/ personnel.

During this activity, the required information/ data will be collected from Nalcor.  The type of information/ data required will include many of the items listed in the shareholders letter.  This will include the Nalcor Project Management Plan/Project Management Manual which documents the processes used to manage scope, cost, schedule and risk.

The request listing will also include source information that is used for the generation of management reports and the corresponding reports provided to the Oversight Committee. 
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Approach

Task 2: Execution

The execution phase will include an evaluation of the documentation collected, including, as applicable, interviews of Nalcor Project team members (e.g. Project Controls team) to understand the application of cost, schedule, risk and scope management processes.  Key activities will include:

Reviewing the scope, cost and schedule management processes to identify potential gaps and opportunities for improvement

Reviewing risk management processes and reported risks in support of EY’s evaluation of cost and schedule management 

Testing the integrity of information flow from contractor reports into management reports

Identifying key risks and issues in project schedules and costs

Making practical recommendations for improvements

The management processes and controls will be assessed against standards and practices commensurate with projects of the scale and complexity of Muskrat falls.  We will also evaluate the integrity of the associated project reporting processes including the reports basis, structure, content and control.

Periodic status meetings will be the primary tool to keep the Oversight Committee apprised of the engagement status concerning findings, budget, and timing.



Task 3: Reporting

Upon completion of the various tasks described above, EY will document results in a findings and recommendations report. Which will comprise the following information:

Executive Summary

Review Scope and Approach

Summary of Results, including Observations, Impact and Recommendations

Appendices (Interviews conducted, data reviewed and supporting information as required)

The form and nature of the report will be discussed and agreed upon during the planning phase of the review. We would also expect some discussion, review and refinement of the report in discussion with Nalcor after its first draft.
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Timeline and Fee

The following tables illustrate the engagement timing and proposed fee.











































Our proposed fee is exclusive of applicable taxes and out-of-pocket expenses.  Actual out-of-pocket expenses incurred will be passed through without any mark-up.



Timely access to data and respective stakeholders determines the amount of time required to conduct these reviews.  In our experience, similar reviews typically require between 4-6 weeks.  The work plan and fee estimate above are based on timely access to data and Nalcor personnel as well as timely feedback during the reporting phase.  We will work with you to further customize the approach and timeline if required.



		Activities		Wk 1		Wk 2		Wk 3		Wk 4		Wk 5		Wk 6

		Planning and review initiation		 		 		 		 		 		 

		Conducting Kick Off Meetings and initiate collection of data		 		 		 		 		 		 

		Meet with Nalcor IA to plan and review documentation/ reports for potential reliance and identify areas where IA could leverage our work 		 		 		 		 		 		 

		Perform fieldwork including interviews and analysis		 		 		 		 		 		 

		Review and validate results  with Nalcor and Oversight Committee 		 		 		 		 		 		 

		Perform additional review as required		 		 		 		 		 		 

		Write and present draft report		 		 		 		 		 		 

		Finalize and issue the final report		 		 		 		 		 		 



		Resources		 Hours 												Hourly rate		Cost

		David Steele		                4 		                4 		                4 		                4 		                4 		                  4 		               341 		        8,184 

		Richard Noble		                4 		                4 		                4 		                4 		                4 		                  4 		               390 		        9,360 

		Aman Gill		              24 		              24 		              24 		              24 		              24 		               24 		               268 		      38,592 

		Emiliano Mancini		              40 		              40 		              40 		              40 		              40 		               40 		               219 		      52,560 

																Total		   108,696 
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Objective, Scope and Team

Background/ objective
The Muskrat Falls Oversight Committee is accountable to Cabinet for providing reliable and transparent oversight on 
the cost and schedule performance of the Muskrat Falls Project.  The Oversight Committee has requested that EY 
perform a review of the Muskrat Falls Project’s project management processes related to cost and schedule.
The objective of this review is to assess the management processes and controls at the Muskrat Falls Project to give 
the Oversight Committee insight on the appropriateness of such processes and provide the Oversight Committee 
assurance as to the completeness and quality of information being provided to the Oversight Committee.
You have indicated there is commercial sensitivity of the information required to perform this review.  EY will report on 
management’s processes and controls and will work with the Oversight Committee and Nalcor to properly protect 
commercial sensitivity project information. 

Scope 
To deliver on these objectives, the scope of the review includes assessing the appropriateness of the Muskrat Falls 
project management processes related to:
► Schedule management, reporting and control
► Cost management, reporting and control
In addition, in order to properly assess the Schedule and Cost management processes and the objectives of this 
review, EY will be required to assess elements of the Scope and Risk management processes.  
We will work with Nalcor Internal Audit during the planning phase of this engagement to identify opportunity to leverage 
work performed by Internal Audit (avoid duplication) and structure opportunities for Internal Audit to participate or 
leverage the work performed by EY in this engagement.

EY Team
► David Steele – Partner
► Richard Noble – Associate Partner

► Aman Gill – Senior Manager
► Emiliano Mancini – Manager
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Approach

Our approach below shows how we will execute this engagement.  Though our approach is structured, we have 
flexibility to meet your requirements.  The three major components of our approach are: planning, execution and 
reporting.  Detailed activities under each component are described below. 
Planning
Activity 1:  Kick-off meetings

EY will work with the Oversight Committee and the Muskrat Falls Project Group’s point of contact(s) to establish an 
engagement protocol to review and confirm scope of activities and related timing.   
An internal kick-off meeting will be held with the Oversight Committee to develop a common understanding of the scope 
and objectives of the engagement, establish communication/ reporting protocols, and discuss potential risks. Another 
kick-off meeting with Nalcor will be conducted to discuss the scope, data requirements and timing.  
EY will also meet with the Nalcor IA team to review their work completed to date to identify areas where reliance can be 
placed to reduce the scope of work for this engagement.  In addition, areas where IA can place reliance on the work to 
be performed in this engagement will also be identified.
The Nalcor liaison, review and feedback mechanism/ protocol will be co-developed in the planning phase.

Activity 2: Data collection and review

EY will develop an “information and document request listing”.  We will then work within agreed upon protocol to collect 
data from the appropriate point of contact/ personnel.
During this activity, the required information/ data will be collected from Nalcor.  The type of information/ data required 
will include many of the items listed in the shareholders letter.  This will include the Nalcor Project Management 
Plan/Project Management Manual which documents the processes used to manage scope, cost, schedule and risk.
The request listing will also include source information that is used for the generation of management reports and the 
corresponding reports provided to the Oversight Committee. 
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Approach
Task 2: Execution
The execution phase will include an evaluation of the documentation collected, including, as applicable, interviews of 
Nalcor Project team members (e.g. Project Controls team) to understand the application of cost, schedule, risk and 
scope management processes.  Key activities will include:
► Reviewing the scope, cost and schedule management processes to identify potential gaps and opportunities for 

improvement
► Reviewing risk management processes and reported risks in support of EY’s evaluation of cost and schedule 

management 
► Testing the integrity of information flow from contractor reports into management reports
► Identifying key risks and issues in project schedules and costs
► Making practical recommendations for improvements
The management processes and controls will be assessed against standards and practices commensurate with 
projects of the scale and complexity of Muskrat falls.  We will also evaluate the integrity of the associated project 
reporting processes including the reports basis, structure, content and control.
Periodic status meetings will be the primary tool to keep the Oversight Committee apprised of the engagement status 
concerning findings, budget, and timing.

Task 3: Reporting
Upon completion of the various tasks described above, EY will document results in a findings and recommendations 
report. Which will comprise the following information:
► Executive Summary
► Review Scope and Approach
► Summary of Results, including Observations, Impact and Recommendations
► Appendices (Interviews conducted, data reviewed and supporting information as required)
The form and nature of the report will be discussed and agreed upon during the planning phase of the review. We would 
also expect some discussion, review and refinement of the report in discussion with Nalcor after its first draft.
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Timeline and Fee

The following tables illustrate the engagement timing and proposed fee.

Our proposed fee is exclusive of applicable taxes and out-of-pocket expenses.  Actual out-of-pocket expenses incurred 
will be passed through without any mark-up.

Timely access to data and respective stakeholders determines the amount of time required to conduct these reviews.  
In our experience, similar reviews typically require between 4-6 weeks.  The work plan and fee estimate above are 
based on timely access to data and Nalcor personnel as well as timely feedback during the reporting phase.  We will 
work with you to further customize the approach and timeline if required.

Activities Wk 1 Wk 2 Wk 3 Wk 4 Wk 5 Wk 6
Planning and review initiation
Conducting Kick Off Meetings and initiate collection of data
Meet with Nalcor IA to plan and review documentation/ reports for 
potential reliance and identify areas where IA could leverage our work 
Perform fieldwork including interviews and analysis
Review and validate results  with Nalcor and Oversight Committee 
Perform additional review as required
Write and present draft report
Finalize and issue the final report

Resources Hours Hourly rate Cost
David Steele 4 4 4 4 4 4 341 8,184 
Richard Noble 4 4 4 4 4 4 390 9,360 
Aman Gill 24 24 24 24 24 24 268 38,592 
Emiliano Mancini 40 40 40 40 40 40 219 52,560 

Total 108,696 
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